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STANDARD SOFTWARE FOR ANALYZING CRASH TEST DATA 

Introduction 

Guidelines for evaluating the impact performance of a highway safety feature in 
the United States (US) are contained in National Cooperative Highway Research 
Program (NCHRP) Report 350, "Recommended Procedures for the Safety Performance 
Evaluation of Highway Features," dated 1993. Standards for evaluating the impact 
performance of a highway safety feature in the European Union (EU) are contained in 
Committee for European Normalization (CEN) standard EN 1317-1, "Road Restraint 
systems : Parf 1: Termino109y ·and- Ge-neraT Criteria for Test-Metnods,~ aafe_ff_lq:>iir ___ - -
1998. As part of the evaluation process for a given crash test, "occupant risk" 
parameters are calculated and reported in accordance with Report 350 and standard 
EN 1317-1 requirements. 

An effort is being made to move toward harmonized testing and evaluation of 
highway safety features between the US, the EU, and other countries. One area this 
can be accomplished in is the evaluation of occupant risk from a crash test. In fact, 
there are some distinct similarities between the occupant risk criteria used in Report 
350 and standard 1317-1, namely in the computation of occupant impact velocity (OIV) 
and ridedown acceleration (RA) in Report 350, and in the computation of the theoretical 
head impact velocity (THIV) and the post-head deceleration (PHD) of standard 1317-1. 
Most testing agencies in the US and in the EU are computing and reporting both sets of 
occupant risk criteria. 

Computational techniques used to determine occupant risk criteria of Report 350 
and standard 1317-1 can vary among testing agencies. The way the results are 
reported can also vary. A standardized computational and reporting methodology is 
therefore needed for use among the various US and EU testing agencies. To this end, 
the US Department of Transportation, Federal Highway Administration (FHWA), 
contracted with the Texas Transportation Institute, Texas A&M University System, 
through a Cooperative Agreement to develop a standardized software package that 
computes and reports both sets of occupant risk criteria. 

Objectives 

The objective of this cooperative agreement was to develop a standardized code 
for computing occupant risk that can: 

(a) compute occupant risk measures in accordance with the 
recommendations in NCHRP Report 350, 

(b) compute occupant risk measures in accordance with CEN standard EN 
1317-1, and 

-(c) - launch standa-raized codes developed by--the National Highway -
Transportation Safety Administration (NHTSA) and by FHWA to prepare 
tape~ and diskettes of crash test electronic data. 
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Approach 

Initially an effort was made to write the required code around an existing, 
commercially available software package called DADiSP, a code used by some of the 
testing agencies. Protracted studies were made to adapt DADiSP for the intended 
purpose and functionality. When this was unsuccessful, an attempt was made to write 
a user friendly, Windows based, code for inputting necessary data to DADiSP. 
However, the functionality provided by DADiSP version 4.0 for Windows was still 
limited. Specifically, features needed to implement the windows oriented "user friendly" 

_ _ _ interface d~v~loped tq ~uppo_rJ _th~ st~11c:i~_rg §offv.t_ar_e pa.ck_a.9E:l were r:t9t ropus~ enqug_h _ 
to permit implementation within the DADiSP environment. After considerable time and 
effort, it was determined that the best course of action was to abandon the DADiSP 
software platform and develop an independent, Windows-based application that would 
possess all of the desired functionality. This new approach necessitated 
reprogramming of the occupant risk algorithms, development of independent plotting 
routines to permit graphical output to both the screen and printer, and the creation of 
new documentation. 

The user-friendly software utilizes the Windows 95/98 or NT operating system, 
and requires no special proprietary software. A presentation of the Alpha version was 
made at the 1998 Annual TRB meeting, to demonstrate the program, its use, and the 
output options. The program was well received by the testing community, both 
domestically and internationally. Some comments were received at that time. In 
addition, an internal review revealed the need to incorporate additional features, as 
follows: 

1) Help screens were added. 
2) Algorithms were added to calculate and report the maximum 50 msec average 

accelerations and the period over which they occur. 
3) A setup code to install program was added. 

Distribution of the beta version of the program "TRAP" (Test Risk Assessment 
Program) was made during the summer of 1998 to interested test laboratories and to 
the consultant to TTI, Dr. Malcolm Ray, for review. Also, an overview of the program 
was presented to attendees at the summer meeting of A2A04, Subcommittee A2A04 
(02), International Research Activities, held in Seattle, Washington, August 2-5, 1998. 
Disk copies of the program and a draft user's manual were distributed to interested 
parties. 

As a result of the internal and external reviews, further refinements to TRAP 
were made, as follows: 

1) Algorithms were added to calculate vehicular roll, pitch, and yaw angles as 
functions of time, given roll, pitch, and yaw rates. 
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1) Algorithms were added to calculate vehicular roll, pitch, and yaw angles as 
functions of time, given roll, pitch, and yaw rates. 

2) Reporting of the maximum roll, pitch, and yaw angles and time of their 
occurrence was added to the Output Report summary page. 

3) Graphical output was added to provide for plotting of roll, pitch, and yaw angles 
and roll, pitch, and yaw rates. 

The resulting version of the TRAP software (revision 2.0) was distributed on CD 
RQM_dJ.JJiogJhe Slj!llffiE}LQL19J)91o do_mestic_~nctJntern~tion_~JteslJ~t:>Qrfil.orie~g_mL 
other interested parties. An overview of the program was presented to attendees of the 
summer meeting of TRB Committee A2A04, Subcommittee A2A04(2), International 
Research Activities, held in Estes Park, Colorado, August 1-4, 1999. 

Product 

The end product of this agreement consists of the TRAP software code, a TRAP 
User's Manual, and a TRAP Programmer's Guide. The code is available on disk, and it 
includes a setup code for installing the program. The User's Manual describes the 
manner in which TRAP is used. It includes a description of input requirements and 
output options. The User's Manual is attached hereto, as Appendix A. The 
Programmer's Guide is intended for programmers needing to maintain and/or extend 
TRAP's capabilities. It is attached hereto as Appendix B. 

NOTE: IT IS ANTICIPATED THAT UPDATES TO TRAP WILL BE MADE FROM 
TIME TO TIME. THE USER SHOULD REFER TO THE "README" FILE 
IN THE ELECTRONIC VERSION OF TRAP FOR THE LA TEST 
CHANGES. 
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Introduction 
Test Risk Assessment Program (TRAP) is a program designed to determine the effectiveness of a 
roadside safety feature by analyzing data from a vehicle crash test of the feature and calculating 
standardized occupant risk factors. 

TRAP calculates occupant risk factors in accordance with the National Cooperative Highway 
Research Program (NCHRP) guidelines and the European Committee for Standardization (CEN). 

NCHRP Report 350 recommends two risk factors to be computed: (1) the lateral and longitudinal 
components of the Occupant Impact Velocity (OIV)) and (2) the highest lateral and longitudinal 
component of resultant vehicular acceleration averaged over any 10-ms interval subsequent to 
occupant impact also known as the Occupant Ridedown Acceleration (ORA). 

These factors are determined by use of a "flail space" model, details of which were first presented in 
NCHRP Report 230. The occupant is idealized as a lumped mass, constrained within an idealized 
occupant compartment. Planar motion in the horizontal plane is assumed. When vehicular impact 
-oceuFs the occupant moves freely within the compartment until contact-is made with either the side 
or the front of the compartment. After contact, whether with the sides or front of the compartment, 
the occupant is assumed to stick and remain in contact with the compartment during the remainder 
of the event. As such, the occupant then experiences the same acceleration as does the vehicle, 
and these are referred to as "ridedown" accelerations. 

Contact with the compartment occurs when the occupant moves left or right 0.3 m (y direction) or 
forward 0.6 m (x direction). The following procedure is used to calculate the risk factors of NCHRP 
Report 350: 

For Criterion H and I, Table 5.1: 

Vehicular accelerations in the x and y directions are double integrated, independently, to 
determine the time of first contact, either with the side of the compartment (0.3 m) or the 
front of the compartment (0.6m), whichever happens first. OIV in both the x and y 
directions are then computed at this time and reported. The larger value of the two is the 
OIV. Subsequent to contact, 1 O ms moving average occupant ridedown accelerations 
(ORA) in the x and y directions are computed and the largest values are reported. The 
larger value of the two is the ORA. A "linear acceleration," or "trapezoidal rule" integration 
procedure is used. 

For Criterion L: 

The above procedure is repeated, except the OIV in the x direction is selected at the time of 
contact (whether contact is with the side or front of the compartment), and the maximum 
ORA in the x direction subsequent to contact is selected. 

CEN specifies three risk factors: (1) Theoretical Head Impact Velocity (THIV), (2) Post Impact Head 
Deceleration (PHO), and (3) the Acceleration Severity Index (ASI). 

The following procedure is used to calculate the CEN risk factors: 

CEN calculation procedures for THIV and PHO are similar to those used for OIV and ORA 
except that THIV equals the resultant of OIV components in the x and y directions at initial 
occupant contact and PHO equals the resultant of the ORA components in the x and y 
directions subsequent to initial occupant contact. There are two other differences: (a) 
vehicular yaw motions are accounted for in the CEN procedures but are neglected in the 
Report 350 procedures, and (b) the head (occupant) in the CEN procedures can be 
positioned forward of the vehicle's center of gravity prior to vehicular impact whereas the 
occupant is always assumed to be located at the vehicle's center of mass prior to vehicular 
impact in the Report 350 procedures. 

Computation of the ASI involves the determination of moving 50 ms averages of vehicular 
accelerations in the x, y, and z directions. ASI is computed at each of these moving 50 ms 
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intervals through an interaction formula using defined limits for the x, y, and z accelerations. 
The maximum value thus obtained is reported as the ASI. 

Also computed and reported are maximum 50 ms average accelerations in the x, y, and z 
directions. Although not required in either the NCHRP Report 350 or the CEN evaluations, 
some agencies use these values as a measure of performance. 

Also, if the combination of roll, pitch, and yaw rates are input, the program computes roll, 
pitch, and yaw angles with time in accordance with coupled Euler equations. Maximum roll, 
pitch, and yaw angles are then calculated and output on the "Results" page. The sequence 
for determining vehicular orientation is as follows: yaw, then pitch, then roll. The user may 
also plot roll, pitch, and yaw angles with time. To be noted is that in accordance with CEN 
requirements, the yaw angle data used in calculating THIV is determined based on the 
assumption that yaw angle is uncoupled (independent) from the roll and pitch angles. 
Hence, differences may occur between yaw angles computed by the two methods 
- ------ ------·-- -------------- ---- --------------------- ·------·------- ------- ----------- ----~--- -------- ---~----------

For further details, see NCHRP report 350 and CEN document CENfTC 266 N 185 E, 
PrEN1317-1 for detailed information on testing procedures, data acquisition requirements, 
and computing the standardized occupant risk factors. 

Using TRAP 
A good way to get familiar with the capabilities of TRAP is to open the sample TRAP data file 
provided. The installation program for TRAP automatically copies the SAMPLE.TRP file to a 
Samples subdirectory under the main TRAP installation directory (C:\Program Files\Trap by 
default). 

Opening an existing TRAP data file and viewing the results consists of the following steps: 

1. Opening an existing TRAP data file 

Select the Open command from the File menu. This will bring up the standard File Open dialog 
box. Navigate to the directory where the TRAP data file exists, select the appropriate file, and click 
the OK button. NOTE: the sample file provided with TRAP (SAMPLE.TRP) file was installed in 
C:\Program Files\Trap\Samples by default 

2. Running the calculations 

After opening the SAMPLE.TRP file, TRAP will automatically run the calculations. 

3. Viewing the results 

After the calculations have run, the Test Summary report view will automatically come up showing a 
summary of the occupant risk factors calculated. You can also view graphs and tables generated 
by TRAP by selecting which graph or table you wish to see from the Graphs or Tables men·u. 

4. Viewing and/or modifying the Input Data (optional) 

After opening an existing TRAP data file, you can view and/or modify the input data by selecting the 
Input Data command from the Data menu. This will bring up the Data Input form. If you modify any 
of the input data and click the OK button, TRAP will automatically rerun the calculations. Clicking 
the Cancel button on the Data Input form will discard any modifications you have made to the input 
data and will not rerun the calculations. 
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You can also use TRAP to analyze data from a new crash test. 
Analyzing data from a new crash test with TRAP consists of the following steps: 

1. Gathering the required data 
In order for TRAP to compute all the results it is capable of calculating, it needs X, Y and Z 
vehicular accelerations and roll, pitch and yaw rates of the vehicle. 

TRAP is capable of handling situations where all the data it needs is not available. In this case it 
will calculate what it can with the available data. See Performing Calculations for detailed 
information. 

The acceleration data required consists of 3 individual components of acceleration (x,y, and z} 
measured by a triaxial accelerometer mounted at or near the vehicle's center of gravity. 

Sometimes the triaxial accelerometer cannot be mounted at or near the vehicle's center of gravity, 
in which case two triaxial accelerometers must be mounted along the vehicle's longitudinal 
ceRterline-andtwo-setS-0f-accelerati0n data-are-requiredaswellas--thedistancesthe-two 
accelerometers are from the vehicle's center of gravity. 

In either case, all acceleration data must be recorded at the same uniform frequency and should 
have the same time duration. 

The yaw data can be in the form of yaw rate recorded at the same frequency as the acceleration 
data, or yaw angle vs. time where the time must be explicitly specified and does not have to 
correspond to the points in time that accelerations are measured. 

It is recommend that yaw rate be used if available. 

The data recorded during the crash test can exist in one or more files. For example the x, y, and z 
components of acceleration could be stored as individual columns within the same file, or each 
could be stored in separate files. See ASCII data files and Binary data files for more information on 
the required format of the files. 

2. Creating a new TRAP data file 
Run the TRAP program and select the New command from the File menu. 

This will bring up the Data Input form. 

3. Entering the required data using the Data Input form 

Fill in the fields on the Data Input form and then click OK. 

4. Running the calculations 
TRAP automatically runs the calculations after the OK button is clicked on the Data Input form. If 
some data has not been entered then some or all of the items shown on the report may be 
unavailable (marked N/A}. In addition some or all the graphs and tables may be unavailable. 

5. Reviewing the results 
TRAP calculates the standardized occupant risk factors and displays them in the results report 
view. 

TRAP can also display certain information in graphical or tabular format. 

See Results for further information. 

6. Saving the TRAP file. 
You should save the TRAP file by selecting the Save command from the File menu before exiting 
the program. 
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Data Input 
The data necessary for TRAP is entered by the user on the Data Input form. This form is a 
multipage form consisting of the following pages: Description Page, Settings Page, Acceleration 
Page(s), Angular Rates Page, and Yaw Angle Page 

In general, you should step through each page entering the required data. 

Once you have entered the data on all the pages, click OK 

TRAP will automatically run the calculations. 

See Running the Calculations and Viewing Results for more information. 

·TRAP·usesth·e·stgnconventton-c:tocamen~diffNCrtRP·repurt35{}as·shownin·the·figure-betow:-tt··· 

is very important that all input data (accelerations, angular rates and I or angles) uses this same 
sign convention. 

Sign Convention used by TRAP 
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Data Input - Description Page 

The Description page allows you to enter general descriptive information about the current test you 
are analyzing. Most of the data on this page is for reference only and not used in the calculations. 

Test agency, Test number, Test date, Test article: 
These fields contain descriptive information about the test and are for reference only. The values 
entered here will be shown on the Results report view. 

Test vehicle: 
The fields in this box are for reference only. They are not used in any calculations. The values 
entered here will be shown on the Results report view. 

Impact conditions: 
Specify the speed and angle of the impact. These values are for reference only. They are not used 
in any calculations. The calculations are all based on the relative motion of the occupant with 
respect to the vehicle's interior and are not effected by the impact speed or impact angle. The 
values entered here will be shown on the Results report view. 

Distance of theoretical head from center-of-gravity: 
The theoretical head used in determining the THIV and the PHO is assumed to be located at the 
vehicle's center of mass. Specify a non-zero value here only if the theoretical head is positioned 
forward of the vehicle's center of gravity. This value is used by the calculations. 

Once you have filled the fields on this page, go on to the Settings page. 
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Data Input - Settings Page 

The Settings page allows you to specify information about the files that contain data from the test. 

Accelerations are measured at the C.G. 
Check this box if the triaxial accelerometer recording the accelerations is mounted at or very near 
the center of gravity of the test vehicle. 
If the accelerometer cannot be mounted at the vehicle's center of gravity, then two triaxial 
accelerometers must be used and mounted along the vehicle's longitudinal centerline. Note that 
two sets of X,Y,and Z acceleration data will be required in this case. 

Data source: 
Specify whether the input file is ASCII or Binary. 

Acceleration sample rate 

Specify the number of samples per second at which the acceleration data was recorded. 

Available data: 
Specify whether the angular data is Yaw Angle or Yaw Rate. Yaw rate is preferred. It is obtained 
by onboard instrumentation measuring yaw rate. 
If you do not have yaw rate data available you can enter yaw angle vs. time instead and TRAP can 
calculate yaw rate. Yaw angle vs. time is sometimes obtained by measuring yaw angle from 
individual frames recorded by an overhead camera. 

Data source: 
Specify whether the input file is ASCII or Binary. 

Yaw sample rate same as acceleration sample rate 
Check this box if the yaw sample rate is the same as the sample rate used for the acceleration data. 

Yaw sample rate: 
Specify the number of samples per second at which the yaw rate data were recorded. 
Note: If roll and pitch rates are also input, the number of samples per second at which the roll and 
pitch rate data were recorded must equal that for the yaw rate data. 

Once you have filled the fields on this page, go on to the Acceleration page(s). 
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Data Input - Acceleration at CG Page 

This page allows you to specify information about the data source file(s} containing the vehicular 
acceleration data. This page will be shown if you specified that accelerations were measured at or 
near the vehicle's center of mass on the Settings page, otherwise the Acceleration -1 and 
Acceleration - 2 pages will be shown and you will have to enter in two sets of acceleration data. 

Data source files: 
Specify file names for X, Y, and Z data files. The Browse button will allow you to browse for the 
files. NOTE: the acceleration data must be in G's. 

Offset, Column 
These fields allow you to specify the column number and the number of rows to skip (offset). 
See ASCII data files and Binary data files for more information on file formats. 

Once you have filled the fields on this page, go on to the Angular Rates or the Yaw Angle Page. 
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Data Input - Acceleration 1 Page 

This page allows you to specify information about the data source file{s) containing the vehicular 
acceleration data. This page will be shown if you specified that aecelerations were not measured at 
or near the vehicle's center of mass on the Settings page, otherwise the Acceleration at CG page 
will be shown and you will only have to enter in one set of acceleration data. 

Displacement from center of gravity: 
Enter the displacement from the center of gravity for this measurement. 

The value entered is the distance along the longitudinal axis of the vehicle (x-axis) from the vehicle's 
center of gravity to the accelerometer. Distances forward of the center of gravity are positive, and 
distances aft of the center of gravity are negative. The distance is required to be in millimeters. 

NOTE: This field is only shown if the acceleration data was not measured at or near the vehicle's 
center of gravity. 

Data source files: 
Specify file names for X, Y, and Z data files. The Browse button will allow you to browse for the 
files. NOTE: the acceleration data must be in G's: ·· 

Offset, Column 
These fields allow you to specify the column number and the number of rows to skip (offset). 
See ASCII data files and Binary data files for more information on file formats. 

Once you have filled the fields on this page, go on to the Acceleration - 2 Page. 
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Data Input - Acceleration 2 Page 

This page allows you to specify information about the data source file(s) containing the vehicular 
acceleration data. This page will be shown if you specified that accelerations were not measured at 
or near the vehicle's center of mass on the Settings page, otherwise the Acceleration at CG page 
will be shown and you will only have to enter in on'e set of acceleration data. 

Displacement from center of gravity: 
Enter the displacement from the center of gravity for this measurement. 

The value entered is the distance along the longitudinal axis of the vehicle (x-axis) from the vehicle's 
center of gravity to the accelerometer. Distances forward of the center of gravity are positive, and 
distances aft of the center of gravity are negative. The distance is required to be in millimeters. 

NOTE: This field is only shown if the acceleration data was not measured at or near the vehicle's 
center of gravity. 

Data source files: 
Specify file names for X, Y, and Z data files. The Browse button will allow you to browse for the 
files. NOTE: the acceleration data must be in G's. 

Offset, Column 
These fields allow you to specify the column number and the number of rows to skip (offset). 
See ASCII data files and Binary data files for more information on file formats. 

Once you have filled the fields on this page, go on to the Angular Rates or the Yaw Angle Page. 
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Data Input - Angular Rates Page 

The Angular Rates page allows you to enter yaw rate data of the vehicle vs. 
time. As an option, you may also enter roll and pitch rate data. 
This page is only shown if you specified yaw rate on the Settings page. The Yaw Angle page is 
shown if you specified yaw angle on the Settings page. 

Data units 
Enter the units used for the angular rate data (degrees/sec or radians/sec) 

Data source file: 
Specify file name for the file containing yaw rate data for the test you are analyzing. ·The Browse 
button will allow you to browse for the file. If roll and pitch rate data are input, specify the name for 
the file containing roll and pitch rate data for the test you are analyzing. 

Offset, Column 
These fields allow you to specify the column number and the number of rows to skip (offset). 
See ASCII data files and Binary data files for more information on file formats. +, · 

Once you have filled the fields on this page and the other pages of the Input Data and clicked the 
OK button, the program will ask ifyou would like to run the calculations now. Go on to Performing 
Calculations . 
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Data Input - Yaw Angle Page 

The Yaw Angle page allows you to enter information about the yaw angle of the vehicle vs. time. 
This page is only shown if you specified yaw angle on the Settings page. The Yaw Rate page is 
shown if you specified yaw rate on the Settings page. 

Data source file: 
Specify file name for the file containing Yaw angle data for the test you are analyzing. The Browse 
button will allow you to browse for the file. 

Offset, Column 
These fields allow you to specify the column number and the number of rows to skip (offset). 
See ASCII data files and Binary data files for more information on file formats. 

Yaw units 
Enter the units used in the yaw angle data (degrees or radians) 

Time column: 
Enter the column containing the time parameter. NOTE: the time must be specified in seconds. 

Interpolation method: 

The calculation engine will interpolate values between data points using either Linear or Cubic 
Spline methods. The cubic spline method will generally provide greater accuracy. 

Once you have filled the fields on this page and the other pages of the Input Data and clicked the 
OK button, the program will ask if you would like to run the calculations now. Go on to Performing 
Calculations . 
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ASCII Data Files And Binary Data Files 
The acceleration and yaw data files can be in two formats: ASCII or binary. The file format you 
choose depends upon the data file produced by your data acquisition equipment. 

An ASCII data file contains numbers represented as text. Values are arranged in rows and 
columns. In the following example, the ASCII data file is composed of two columns of data. The 
first two rows (lines) consist of header information are not part of the data. Therefore the program 
must be told that the real data starts at an offset of 2. 

~c 1489 

0.0000 
0.0007 
0.0013 
-o~-01t20 
0.0027 
0.0034 
0.0040 
0.0047 
0.0054 

6.720E-04 O.OOOE+OO G's O.OOOE+OO CLASS180 
"AXCG II 0 20 -11 654 -0. 6768721 

0.0615338 
0.0307669 
0. 0923007 
0·~·15-3e3-.t6-
0. l 8460l5 
0. 0923007 

-0.0615338 
-0.1846015 
-0.2153684 

Binary data files contain data in 32-bit float or 64-bit double, IEEE format. Since binary files have no 
new-line character, it must be told how many columns are in the file. For example, a data file 
containing 36 numbers could be 6 columns by 6 rows, 4 by 9, or 9 by 4. An offset can still be 
specified for a binary file if there is some information at the beginning of the file you wish to skip 
over. For binary files the offset is specified in bytes rather than rows(lines). 
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Performing Calculations 
The program will automatically run the calculations if you have changed any information on the 
Input Data pages, or if the calculations have not been run yet. 

Once the calculations have run, the Results will appear on screen. Some results may not be 
available if any of the required data needed to compute them is missing from the input data. 
Unavailable items will be marked NIA in the Test Summary Report. TRAP will compute as much as 
it can with the data it is given. The following table summarizes the data required to compute each 
item in the Test Summary Report. 

OIV_~X __ x 
-·--- --- --~--- ---------- --- -- ------- -·· -

OIV-Y x 
THIV x x X* 

Ridedown Accel. X x 
Ridedown Accel. Y x 
PHO x x 
ASI x x x 
Max 50-msec Avg. X x 
Max 50-msec Avg. Y x 
Max 50-msec Avg. Z x 
Max Roll angle x x x 
Max Pitch angle x x x 
Max Yaw angle x x x 

*As an alternative, yaw angle versus time may be input. 
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Results 
Once the calculations have been performed, the Results window will show a Test Summary Report. 

To view this window later select Results from the Data Menu. 

You can print these results by pressing the Print button on the toolbar, or by selecting Print from the 
File menu. 

The Graphs menu allows you to generate several different graphs. 

The Tables menu allows you to generate several different tables showing the same data that is 
available in the graphs, but in tabular format. 

See Graphs and Tables for more information. 
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Graphs 
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To view the graphs, select Graph All from the Graph menu. You may also draw one graph at a 
time, by selecting from the choices in the Graph menu. 

You can edit the properties of an individual graph. To edit a graph, select Properties from the Edit 
menu , or double-click on a graph. 

Each graph has three sets of properties: 

Graph : Controls general settings 

Plots : Which plots to show on a certain graph 

Axes : Handles axes scale settings 

You may also arrange the positions of the annotation and legend in the graph by clicking on them 
and dragging them to the desired location. 

Once you have a suitable graph, you may print it by pressing the Print button on the toolbar, or by 
selecting Print from the File menu . You may also copy an image of the graph to the clipboard by 
selecting the Copy command from the Edit menu . 

NOTE: When copying graphs to the clipboard for pasting into other applications, you will get the 
best results by maximizing the size of the graph before performing the copy operation. 
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Graph Parameters Form - Graph Page 

The Graph page of the Graph Parameters form has several options allowing you to control the 
appearance of a graph. 

Graph title 
Type in the title for the graph here. 

Show gridlines 
Check this box if you want gridlines displayed on the graph. 

Show legend 
Check this box if you want the legend displayed on the graph. 

Show annotation 
Check this box if you want the annotation to be displayed on the graph. 

Auto fill 
Check this box if you want TRAP to automatically fill in the annotation for you. 

NOTE: This field is disabled unless the Show annotation box is checked. 

Text box 

If the Auto fill box is not checked, you can type in the text you want. 

NOTE: This field is disabled unless the Show annotation box is checked. 

If the Auto fill box is checked, this box displays the default text that will be shown in the annotation 
on the graph. 

Left position, Right position 
These fields allow you to control the positioning of the annotation 

You may also drag the annotation by mouse when the Graph Settings window is closed. 

NOTE: These fields are disabled unless the Show annotation box is checked. 
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Graphs Parameters Form - Plots Page 

For some graphs, more than one plot( curve) may be shown on the same graph. This page allows 
you to control which plots are shown on a graph and the properties (line color, style, and width) of 
those plots. 

The list box at the top of the page shows all plots available for the specific graph. 

After selecting a plot in the list of plots, you may make it visible on the graph be checking the Show 
checkbox. Once a plot is visible, you may adjust the line color, style, and width. 

NOTE: the Color, Style, and Width fields will all be disabled if the Show checkbox is not checked. 
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Graph Parameters Form ... Axes Page 

This page allows you to control the limits of the scale associated with each axis on a graph. 

For each of the X and Y axes, you may use auto scale, or type in your own minimum and maximum 
values. 
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Tables 

Time Raw 60Hz Filtered 50 msec Avg 
(sec) (G's) (G's) (G's) 

0.0000000 0.0615338 0.0370095 -1. 7401768 
0.0006720 0.0307669 0.0381394 -1. 8509377 
0.0013441 0.0923007 0.0319651 -1.9539043 
0.0020161 0.1538346 0.0154066 -2.0511277 
0.0026882 0.1846015 -0.0141964 -2.1278399 
0.0033602 0.0923007 -0.0587751 -2 .1672216 

-0~0040323 ~o ~ 06153ZS- -;.:.o, 1195005 -- - ;;_-z~ 1·65saur---
0.0047043 -0.1846015 -0.1970568 -2.1286603 
0.0053763 -0.215368'1 -0.2919406 -2 .0683572 
0.0060484 -0.2461353 -0.'1045882 -1. 9973882 
0.0067204 -0.3692030 -0.5352985 -1.9264192 
0.0073925 -0.5230376 -0.6840978 -1.8657058 
0.0080645 -0.738'1060 -0.8506290 -1.8242730 
0.0087366 -0.9230075 -1.0344045 -1.8041719 

Select the table you wish to view from the list of available tables on the Table Menu. 

Tables allow you to see data that is available in the graphs in a tabular text format 

Each graph that you can display with TRAP has a corresponding table. 

You can display a table by selecting which table you wish to see from the menu 

There are no formatting options for tables. 

You can copy the entire contents of a table window to the Clipboard by selecting the Copy 
command from the Edit menu. You cannot select only portions of the table to copy - the Copy 
command always copies the entire contents of the table window to the Clipboard where it can be 
pasted in to other applications. 
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Menu and Toolbar Reference 

File Menu 

New - Creates a new TRAP data file 

Open ••• - Opens an existing TRAP data file 

Close - Closes the currently open TRAP data file 

Save - Saves the currently open TRAP data file 

Save As ... - Saves the currently open TRAP data file with a new name 

Print ... - Prints the active window 

Print Preview - Previews how the active window will appear when printed 

Print Setup ... - Brings up the Print Setup dialog to allow changing printer settings 

1,2,3,4 - Displays a list of the most recently opened TRAP data files 

Exit - Exits TRAP 
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Edit Menu 

This menu can be used to copy graphics and text to the Clipboard for pasting into other 
applications. 

Copy 
Use this command to copy the contents of the active window to the Clipboard. This option is only 
available for Graphs, Tables, and the Summary report · 

Properties •••• 

Use this command to display the Graph Parameters Form for the currently active Graph window. 
This command is only avaitablewhena Graph window is the active window-

The Properties item on the Edit menu is only available for a graph window. See Graphs for 
information on modifying graphs. 

Data Menu 

Input Data ••• 
Brings up the Input Data form 

Calculate 
Runs the calculations 

Results 
Brings up the Results report view 

Reporting Format 
Runs external data formatting programs 

These programs are separate programs independently developed from TRAP. These programs are 
all DOS based and run in their own separate DOS window. 

TRAP only provides a means to launch these other programs. There is no communication of data 
between TRAP and these other programs. These programs generate standard formatted files 
specified by the respective agency or organization. 

NOTES: 
1. FHWA has two programs, one to generate a header, and one to generate the main body of the 
report. 

2. There is no CEN formatting program available at this time, selecting the CEN option will launch a 
batch file that does nothing. When a CEN formatting program becomes available in the future, it 
can be called from the batch file, and thus launched from TRAP. 
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Graph Menu 

To view the graphs, select Graph All from the Graph menu. You may also draw one graph at a 
time, by selecting from the choices in the Graph menu. 

Once one or more graphs are on the screen, you may arrange the windows. See the Windows 
menu for more information. 

See Graphs for information on modifying the graphs. 

Note: A plot produced by the "Yaw Angle" option is based on the assumption that yaw angle is 
uncoupled or independent from roll and pitch angles. Plots produced by the "Roll, Pitch, and Yaw 
Angles" option are determined by use of the Euler coupled equations (see Introduction for further 
discussion). Differences may therefor occur between the yaw angles thus plotted. 

Table Menu 

Select the table you wish to view from the list of available tables. 

See Tables for more information. 
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Window Menu 

Cascade 
Arranges the currently open windows in an overlapping fashion 

Tile 
Arrang.e.s.J~11 QPfill w.lndQw~Jn_Q_nQn-:QY.eI.lappjng_ fa~h1Ql1_, 

Close All 
Closes all the open windows. This does not close the open TRAP data file, just the open 
windows. 

1,2,3, etc. 
This list shows the currently open windows. Select any window from this list to bring it to the 
forefront. 
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Tool bar 

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar 
provides quick mouse access to many tools used in TRAP, 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

Greate-a-new TRAP data-fite. 

Open an existing Trap data file. TRAP displays the Open dialog box, in which you can locate and open the 
desired file. 

Save the current TRAP data file with its current name. If you have not named the project, TRAP displays 
the Save As dialog box. 

Print the active window. 

Display the Data Input Form 

View Results 
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APPENDIX 8 

TRAP Programmer's Guide 

This Programmer's Guide is intended for programmers needing to maintain and/or 
extend the capabilities of TRAP (Test Risk Assessment Program). TRAP 
calculates several occupant risk parameters as detailed in National Cooperative 
Highway Research Program (NCHRP) Report 350 (1993), and in Committee for 
European Normalization (CEN) document EN 1317-1( April 1998). Report 350 
p_(lr~un~ters.impl~rn~nted .. bYTRAPcir_~q~_t~il~<tJn 8pJ'.:>~flgi~.A_(§~c~i9n~84?ngA!51 
as well as Appendix F of Report 350. CEN parameters implemented by TRAP are 
detailed in Sections 6 and 7 of the CEN document. See the NCHRP and CEN 
documents for detailed information on testing procedures, data acquisition 
requirements, and computing the standardized occupant risk parameters. 

Compiler 

TRAP is written in C++ using Microsoft Foundation Classes (MFC). The compiler 
used is Microsoft Visual C++ Version 5.0 

Third Party Libraries 

The only third party software used in TRAP is the Quinn-Curtis graphing package. 
The following classes are derived from classes in the Quinn-Curtis package: 

CGraphWnd : public QCGraphWnd 
CGraphView: public QCPageView 
CGraphPrintWnd: public QCPageWnd 

CCurve uses the class QCStaticData 

Curve Fitting 

Curve fitting and interpolation are sometimes necessary when preprocessing the 
raw input data in preparations for the calculations. The calculations expect the data 
to all be on the same time interval. When the raw data are on different time 
intervals, interpolation is used to make all the arrays on a common time interval. 
This is explained in more detail in a later section in the Programmers 
Documentation named "Preprocessing Step". Both linear interpolation and cubic 
spline techniques are used. 
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Linear Interpolation 

Of the two types of curve fitting used in TRAP linear interpolation is the least 
accurate but simplest to implement. The linear interpolation algorithm finds 
Y; given X; and two arrays KnownX[]and KnownY[]. 

Find j such that KnownXU] <= X; < KnownXU+1] using the hunt() routine from 
Numerical Recipes. 

dy = ( KnownYU+1] - KnownYU]) I (KnownXU+1] - KnownXU]) 
.. Yr== KnownY U] + (x; - KnownX UJ) * (dy) 

Cubic Spline 

The spline interpolation routines used in TRAP are taken from Numerical 
Recipes in C Second Edition pages 113-115. These pages contain the code 
for the spline() and splint() functions and explain the process much better 
than this document could. The only modification made to the routines from 
Numerical Recipes used in TRAP is in the splint() function. The version used 
in TRAP takes an extra parameter to return the first derivative as well as the 
value of the spline function at the desired x point. 
The differentiation calculation within the Cubic Spline routine is from the 
equation for calculating the derivative given in Numerical Recipes as eq. 
(3.3.5) on page 95 as follows. 

dy/dx = (y[ j+1] - y[ j]) I (x[ j+1] - x[ j]) -
(3A"2 - 1)/6 * (x[j+1]- x[j]) d2y[j] + 
(38"2 -1)/6 * (x[j+1]- x[j]) d2y[j+1] 

Where A, B, and the second derivative (d2y) are already calculated in the 
spline interpolation routine. 

The following table lists all the routines within TRAP that use any~ihtegration, 
differentiation, interpolation, or cubic spline routines. 

CalculateResults() in calculate.cpp 

SetupCalcYawRates() in CarUtilDoc.cpp 

SetupYawAcclDiffRates() in CarUtilDoc.cpp 

B-2 

Integrate() in calculate.cpp 
Filter() in calculate.cpp 
ButterworthFilter() in calculate.cpp 
Splint() in CarUtilDoc.cpp 
Linearlnterp() in CarUtilDoc.cpp 
Splint() in CarUtilDoc.cpp 



Sign Convention 

TRAP uses the sign convention documented in NCHRP report 350 as shown in 
the figure below. It is very important that all input data (accelerations, angular 
rates and I or angles) uses this same sign convention. 

Sign Convention used by TRAP 

Mathematical Computations 

Integration 

There is a single integration routine in TRAP that uses the Trapezoidal Rule 
to compute the integral of the function provided. 

Differentiation 

There are several places in TRAP where the derivative of a curve is 
computed. The derivative computed is equivalent to the slope of the piece
wise linear function between provided data points. 

TRAP Specific Calculations 

There are several steps involved in the TRAP calculations. The user must first 
specify what types of data are available. The program then attempts to read in the 
data specified by the user setting flags indicating the availability of data in the 
process. There is an availability flag for each of the data sets needed for the 
calculations (X acceleration, Y acceleration, Z acceleration Yaw, Roll and Pitch 
data). The application then calculates as much as it can given the availability of 
data. Certain values cannot be calculated if all data sets are not available. 
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Preprocessing step 

After the data is read in and the application knows what data is truly 
available, all data must be converted to the same time interval. The 
assumption is made that the first value in each data set occurred at the same 
point in time but there is the possibility that the different sets of data were 
sampled at different rates. If the data has been sampled at different rates 
the application must first determine which of the sampling rates is highest 
(gives the smallest change in time between data points). This highest 
sampling rate will be referred to as the calculation sampling rate and the 

··multiplicative inverse of the calculation sampling rate wH~oe referred· to as 
the calculation delta time. The application must then determine which set of 
data limits the number of data points that can be used for the calculations. 
The data used for the calculations in TRAP is to be interpolated not 
extrapolated. The application must determine, from the sampling rates and 
number of data points for the individual data sets, the earliest time at which 
one of the data set ends. This time will be referred to as the max data time. 
The application must then calculate the greatest time value that is both a 
multiple of the calculation delta time and less than or equal to the max data 
time. This time will be referred to as the calculation max time. The number 
of data points to be used for the calculations is then known to be the 
calculation max time divided by the calculation delta time. The data sets with 
a different sampling rate than the calculation sampling rate are then re
sampled at the calculation sampling rate using the curve fitting technique 
selected by the user. The default curve fitting technique is cubic spline but 
linear interpolation is also available to the user. 

Calculation step 

At this point the application knows which data sets are available and has 
access to data sets with the same sampling rate and the same number of 
data points. The applications will attempt to cal.culate the following values: 

Occupant Impact Velocity (OIV) 
Time of impact 
Interior side of vehicle impacted 
Impact Velocity in x-direction 
Impact Velocity in y-direction 

Theoretical Head Impact Velocity (THIV) 
Time of impact 
Interior side of vehicle impacted 
Resultant Impact Velocity 

Ridedown Accelerations 
Max. 10-msec moving average acceleration in x-direction after 
occupant impact 
Max. -10-msec moving average acceleration in y-direction- after 
occupant impact 
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PHO 
Max. 10-msec moving average resultant acceleration in x and y 
directions after occupant impact 

ASI 
Max. 50-msec moving average accelerations 

x-direction 
y-direction 
z-direction 
xy resultant acceleration 
xyz resultant acceleration 

Maxroll, piteh,and-yawangles. 

Each of these values is dependent on the availability of one or more data 
sets. Therefore, the calculation routine contains many conditional 
statements to check the availability of data before a calculation is actually 
performed. The following table details the calculation dependencies. 

OIV-X x 
OIV-Y x 
THIV x x X* 
Ridedown Accel. X x 
Ridedown Accel. Y x 
PHO x x 
ASI x x x 
Max 50-msec Avg. X x 
Max 50-msec Avg. Y x 
Max 50-msec Avg. Z x 
Max Roll angle x x x 
Max Pitch angle x x x 
Max Yaw angle x x x 

*As an alternative, yaw angle versus time may be input. 

Filtering 

For plotting purposes, NHCRP Report 350 recommends acceleration data 
be filtered using a CFC (Channel Frequency Class) of 60 Hz. TRAP uses 
a Butterworth 4-pole phaseless digital filter as documented in SAE J211. 
The filtering routine used by TRAP is a direct implementation of the algorithm 
detailed in SAE J211--:- - ----
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Post-calculation step 

If all data sets are not available the data to be displayed in some curves, 
graphs or tables may not be available. Each curve, graph and table object 
contains an availability flag that is set after the calculations based on the 
availability of data sets. If the data to be displayed by a curve or a table 
could not be calculated then the availability flag for that curve or table is set 
to false. If none of the curves to be displayed by a graph are available then 
the availability flag for the graph is set to false. 

Executing the calculations __ 

The calculations are run automatically when a project file is opened and 
when any changes are made to the input data. 

Subroutines 

The following table lists all the classes used in TRAP with a description of how each 
is used. Note: TRAP was originally called CarUtil, so many of the classes retain 
that name. Also, when used below, QC means Quinn-Curtis 

B-6 



CAccelerationPage 

CCarUtilApp 
CCarUtilDoc 

CCarUtilView 
CChildFrame 

-GColumr 

CCurve 
CDatalnputSheet 

CDescriptionPage 

CErrorView 
CGraph 

CGraphAxesPage 

CgraphCurvesPage 

CGraphFrame 
CgraphGeneralPage 

CGraphPrintWnd 

CgraphPropertySheet 

CGraphView 
CGraphWnd 
ClnputData 
CMainFrame 
CReportView 
CSettingsPage 

CT able 

CT able View 
CYawPage 

FILTER 

Dialog 

Property Page 

App 
Doc 

View 
Frame 

Property Sheet · 

Property Page 

View 

Property Page 

Property Page 

Frame 
Property Page 

Property Sheet 

View 

Frame 
View 
Property Page 

View 
Property Page 

Popup dialog with program info shown when user 
selects "About TRAP ... " from the Help menu 
"Acceleration ... " tab property page used to enter 
acceleration data 
Main Application class 
TRAP's doc class. This stores all the data used in 
TRAP 
Default view for the application 
Application's CMDIChildWnd 
Stores a single-col1.1mn-of data, includingvaluesand 
titles, for use by CTable 
Stores settings for a single curve for use by CGraph 
Property sheet for editing input data. Contains 4 pages 
for Description, Settings, Acceleration, and Yaw data 
"Description" tab property page used to enter general 
description data 
Displays list of errors and/or warnings in a text window 
Stores all setup info for a graph. Contains a list of 
curves (CCurve) 
"Axes" tab property page used to enter axis settings for 
a graph 
"Plot" tab property page used to enter curve settings for 
a graph 
MDI frame to display a Graph View in 
"Graph" tab property page used to enter general 
settings for a graph 
QC override. Special window used for drawing graph 
into when it is being printed 
Property sheet for editing graph settings. Contains 3 
pages for General, Curves, and Axis settings 
QC override. View (window) used to display graphs 
QC override. Used to override QC graph functionality. 
Stores all input data entered by user 
MDI main frame window 
Displays results as text report in a view 
"Settings" tab property page used to select type of raw 
data to read in 
Stores information to display a table of data. Contains 
a list of columns (CColumn). The table is displayed 
using CTableView 
Display a table in a text window. 
"Yaw .. " tab property page used to enter yaw/angular 
data 
Helper class used to set up parameters for Filter() 
function 
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SDMVI 

There are some additional classes that were used as a layer between the standard MFC 
DocNiew classes and our application. 

The default DocNiew models available in MFC (i.e. SDI, MDl)were not adequate for TRAP. 
TRAP has a hybrid DocNiew architecture which allows only a single document to be open 
at a time, but allows multiple views on the doc. We call this model"Single Document -
Multiple View Interface" or SDMVI for short. The special behavior includes such things as 
updating the Window menu properly and insuring that only one instance of each of our 
application's windows are shown at a time. This special behavior has been implemented 
by sub-classing off of some of the standard DocNiew related MFC classes. Some of our 
SDMVl.Cfasseswere.in-fUrn su6~Cfasses.offofsome offne slandard-appffcation class-es; 
others were used directly. This is shown in the following table. 

CMDIChildWnd 
CMultiDocTemplate 
CDocument 
CMDIFrameWnd 
CWinApp 

Definitions 

CSDMVIChildWnd 
CSDMVIDocTemplate 
CSDMVIDocument 
CSDMVIFrameWnd 
CSDMVIWinApp 

CGraphFrame 

CCarUtilDoc 
CMainFrame 
CCarUtilApp 

The most important variables in the program are in two particular classes. Those 
are CCarUtilDoc and ClnputData. The variables are commented in the header (.h} 
files for these two classes. For convenience those sections of the file are shown 
here. 
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II*••••••• Description 
CString m_strTestAgency ; II Test agency 
CString m_strTestNumber; II Test number 
CString m_strTestDate; II Test date 
CString m _strTestArticle ; II Test article 
CString m_strVehicleDescription ;//Vehicle description 
double m_dlnertiaMass; II Test inertia mass (kg) 
double m_dGrossMass; II Gross static mass (kg) 
double m_ dlmpactSpeed ; II Impact speed (km/h) 
double m_dimpactAngle; II Impact angle (degrees) 

-- double m_dTheorHeadDistaneeX;-- II Distance oftheoretical head-from CG (mm) 
11* • • • ** * * Settings 
double m_dSampleRate; 
BOOL m_bYawSampleRateSame; 
double m_dYawSampleRate; 
BOOL m_bAccelMeasuredAtCG ; 
int m_nAccelDataSource ; -
int m_nYawDataType; 
int m_nYawDataSource; 
II******** Acceleration 1 

II Acceleration sample rate (samples/sec) 
II Flag indicating if Yaw data is sampled at same rate as accel data 

II Yaw sample rate (samples/sec) 
II Flag indicating if Acceleration components were measured at CG 
II Acceleration file type (ASCII, Binary-float, Binary-double) 

II Yaw data type (Angle or Rate) 
II Yaw data file type (ASCII, Binary-float, Binary-double) 

double m_dAccelDisplacementFromCG[2] ; II Displacement from CG (mm) 

CString m_strAccelXFilePath[2] ; II X Acceleration data file pathname 
int m_nAccelXFile0ffset[2]; II X Acceleration data file offset 
int m_nAccelXFileNCols[2]; II X Acceleration data file column count 
int m_nAccelXFileCol[2] ; II which column contains X Acceleration data 

CString m_strAccelYFilePath[2] ; II Y Acceleration data file pathname 
int m_nAccelYFile0ffset[2]; II Y Acceleration data file offset 
int m_nAccelYFileNCols[2] ; II Y Acceleration data file column count 
int m_nAccelYFileCol[2]; II which column contains Y Acceleration data 

CString m_strAccelZFilePath[2] ; II Z Acceleration data file pathname 
int m_nAccelZFile0ffset[2] ; II Z Acceleration data file offset 
int m_nAccelZFileNCols[2] ; II Z Acceleration data file column count 
int m_nAccelZFileCol[2] ; II which column contains Z Acceleration data 

11••••••** Yaw 
CString m_strYawUnits; 
CString m_strYawFilePath; 
int m_nYawFileOffset; 
int m_nYawFileNCols; 
int m _ n YawFileCol ; 
int rn_nYawFileTimeCol; 
int rn_nYawinterpMethod; 

II******** Roll 

II Units for Yaw data (deg/sec, rad/sec) 
II Yaw data file pathname 
//Yaw data file offset 
II Yaw file column count 
II which column contains Yaw data 
II which column contains Time data 
II Interpolation method for getting rate from angle (linear, cubic spline) 

CString m_strRollFilePath; II Roll data file pathname 
int m_nRollFileOffset; II Roll data file offset 
int m_nRollFileNCols; II Roll file column count 
int m_nRollFileCol; II which column contains Roll data 

//********Pitch 
CString m _strPitchFilePath ; II Pitch data file pathname 
int m_nPitchFileOffset; II Pitch data file offset 
int m_nPitchFileNCols ; II Pitch file column count 
int m_nPitchFileCol ; II which column contains Pitch data 
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CString m_strWarnings; 
CString m _ strErrors ; 
CString m_strReport; 
CString m_strAnnotation ; 
BOOL m_bAnnotationAutoFill; 
application 

ClnputData m_lnputData; 
BOOL m_bNeedToRecalc ; 
int m_nErrors ; 
int m---nWamirigs ; . 

CGraph *m_pGraphl; 
CGraph *m_pGraph2; 
CGraph *m_pGraph3; 
CGraph *m_pGraph4; 

. CGraph *m_pGraph5; 
CGraph *m _pGraph6 ; 
CGraph *m_pGraph7; 
CGraph *m_pGraph8; 
CGraph *m _pGraph9 ; 
CGraph *m_pGraphlO; 

CTable *m _pCurrentTable ; 

CTable *m_pTablel; 
CTable *m_pTable2; 
CTable *m _pTable3 ; 
CTable *m _pTable4 ; 
CTable *m _pTable5 ; 
CTable •m_pTable6 ; 
CTable *m_pTable7; 
CTable *m _pTable8 ; 
CTable *m_pTable9; 
CTable *m_pTablelO; 

II stores warning messages for display by CErrorView 
II stores error messages for display by CErrorView 
II stores results report for display by CReportView 

II used on graph settings form to build graph annotation 
II indicates if annotation will be entered by user or created automatically by 

II contains all input data entered by user 
II flag indicating if calculations need to be done 

II count of errors that exist 
··!Tcountofwamings·marexisr 

II Setup information for Graph l 
II Setup information for Graph 2 
II Setup information for Graph 3 
II Setup information for Graph 4 
II Setup information for Graph 5 
II Setup information for Graph 6 
II Setup information for Graph 7 
II Setup information for Graph 8 
II Setup information for Graph 9 

II Setup information for Graph 10 

II Used to transfer the table pointer into the Table View 

II Setup information for Table I 
II Setup information for Table 2 
II Setup information for Table 3 
II Setup information for Table 4 
II Setup information for Table 5 
II Setup information for Table 6 
II Setup information for Table 7 
II Setup information for Table 8 
II Setup information for Table 9 

II Setup information for Table I 0 

II curve data arrays for OIV Occupant Impact Time marker shown on X and Y acceleration graphs 
double •m_adOccupantlmpactTimeOIV _Xl ; 
double *m_adOccupantlmpactTimeOIV _ Yl ; 
double •m_adOccupantlmpactTimeOIV _X2 ; 
double •m_adOccupantlmpactTimeOIV_Y2 ; 

II curve data arrays for TIIlV Occupant Impact Time marker shown on X-Y resultant graph 
double •m_adOccupantlmpactTimeTIIlV _X; 
double •m_adOccupantlmpactTimeTIIlV _ Y; 
int m_nOccupantlmpactTimeCount ; 

II Curves showing Occupant Impact 
CCurve *m_pOccupantlmpactCurvel ; 
CCurve *m_pOccupantlmpactCurve2; 
CCurve •m_pOccupantlmpactCurve4; 

II Curves for Filtered Data 
CCurve *m_pFilterCurvel ; 
CCurve •m_pFilterCurve2; 
CCurve *m_pFilterCurve3 ; 
CCurve *m_pFilterCurve4 ; 

<::curve •m_pFilterCurve5_; _ 
CCurve *m_pFilterCurve6 ; 
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CCurve •m_pFilterCurve7 ; 
CCurve •m_pFilterCurve8 ; 

II Curves for Raw Data 
CCurve •m_pRawCurvel ; 
CCurve•m_pRawCurve2; 
CCurve •m_pRawCurve3; 
CCurve •m_pRawCurve4 ; 
CCurve •m_pRawCurve5 ; 

II Curves for 50-msec average 
CCurve •m_pAverageCurvel; 
CCurve •m_pAverageCurve2; 
CCurve •m_pAverageCurve3; 

-·ccurve •·myAveragCCurve4 ~
ccurve •m_pAverageCurve5; 
CCurve •m_pAverageCurve6 ; 
CCurve •m_pAverageCurve7; 
CCurve •m_pAverageCurve8; 

II Curves for I 0-msec average 
CCurve •m_p!OmsMoveAvgCurvel; 
CCurve •m_p!OmsMoveAvgCurve2; 
CCurve •m_p!OmsMoveAvgCurve3; 
CCurve •m_p!OmsMoveAvgCurve4; 
CCurve •m_p!OmsMoveAvgCurve5; 

II Curves for Roll, Pitch and Yaw Rate graph 
CCurve •m_pCurveCoupledYawRate; 
CCurve •m_pCurveRollRate ; 
CCurve •m_pCurvePitchRate; 

II Curves for Roll, Pitch and Yaw Angle graph 
CCurve •m_pCurveCoupledYawAngle; 
CCurve •m_pCurveRollAngle; 
CCurve •m_pCurvePitchAngle; 

II Variables for reading in raw Yaw Angle data from file 
int m_nFileYawAngleArraySize; II number of Yaw Angle data points read in from file 
double •m_pdFileYawAngleTime; II Time corresponding to Yaw Angle value from file 
double •m _pdFile Yaw Angle ; II Yaw Angle from file 

II Variables for reading in raw data from file all at same time intervals 
int m_nFileArraySize; II number of points 
double •m_pdFileTime; //times (shared by all arrays) 
double •m_pdFileAccelXI ; II X component of acceleration I from file 
double •m_pdFileAccelYI ; //Y component of acceleration l from file 
double •m_pdFileAccetzl; //Zcomponentofacceleration l from file 
double •m _pdFileAccelX2 ; II X component of acceleration 2 from file 
double •m_pdFileAccelY2 ; II Y component of acceleration 2 from file 
double •m _pdFileAccelZ2 ; II Z component of acceleration 2 from file 
double •m _pdFile Yaw Rate ; II Yaw Rate from file 
double •m_pdFileRollRate ; II Roll Rate from file 
double •m_pdFilePitchRate ; II Pitch Rate from file 

int m_nAcclArraySize; 
int m_nYawRateArraySize; 
int m_nRol!ArraySize; 
int m_nPitchArraySize; 

BOOL 
BOOL 
BOOL 

m _ bXAccelDataA vailable; 
m _ b Y AceelDataA vailable; 
m _ bZAccelDataA vailable; 

II indicates ifX acceleration data is availl!ble 
II indicates ifY acceleration data is available 
II indicates if Z acceleration data is available 
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BOOL 
BOOL 
BOOL 

m bYawDataAvailable; 
m = bRollDataA v~ilable; 
m _ bPitchDataA vailable; 

II indicates if yaw data is available 
II indicates ifroll data is available 
II indicates if pitch data is available 

II Calculated roll, pitch and yaw arrays 
int m_nRollPitchYawSize; II Number of points in roll, pitch and yaw calculated arrays 
double *m_pdCalcRPYTime; II Time, common for all roll, pitch and yaw calculated arrays 
double •m_pdCalcCoupledYawRate; 
double •m_pdCalcCoupledYawAngle; 
double *m_pdCalcRollRate ; 
double •m_pdCalcRollAngle; 
double •m_pdCalcPitchRate; 
double •m_pdCalcPitchAngle; 

II Calculated arrays 
int m_nCalcArraySize; 
double *m_pdCalcTime; 
double *m _pdCalcAccelXCG ; 
double •m_pdCalcAccelYCG; 
double •m _pdCalcAccelZCG ; 
double *m_pdCalcYawRate; 
double *m_pdCalcYawAngle; 

II Number of points in calculated arrays 
II Time, common for all calculated arrays 
II Calculated X Acceleration at CG 
II Calculated Y Acceleration at CG 
II Calculated Z Acceleration at CG 

II Calculated yaw rate 
II Calculated yaw angle 

double *m _pdCalcPHD ; II Calculated PHD 
double *m_pdCalcResultantxY; 
double •m_pdCalcResultantxYZ; 
double •m _pdCalcASI ; 

II Calculated X-Y resultant acceleration 
II Calculated X-Y-Z resultant acceleration 

II Calculated ASI 

II Data storage for 10-msec average curves 
double •m_pdCalcResultantxYFiltered; 
double •m_pdCalcResultantxYZFiltered; 
double •m _pdCalcAccelXFiltered ; 
double •m _pdCalcAccelYFiltered ; 
double *m_pdCalcAccelZFiltered; 
double •m_pdCalcYawRateFiltered; 
double •m_pdCalcYawAngleFiltered; 

II Data storage for 50-msec average curves 
double •m_pdCalcAccelXAveraged; 
double •m_pdCalcAccelYAveraged; 
double •m_pdCalcAccelZAveraged; 
double •m _pdCalcResultantxY Averaged ; 
double •m_pdCalcResultantxYZAveraged; 

II Data storage for 10-msec average curves 
double •m_pdCalcXIOmsecMoveAvg; 
double •m_pdCalcYlOmsecMoveAvg; 
double •m_pdCalcZIOmsecMoveAvg; 
double •m_pdCalcXYIOmsecMoveAvg; 
double •m_pdCalcXYZIOmsecMoveAvg; 

double m_dCalcOccupantlmpactTime; II CEN impact time 
int m_nlmpactlndex II CEN impact time index 

double m _ dNCHRPOccupantlmpactTime ; II NCHRP impact time 
int m_nNCHRPimpactlndex ; llNCHRP impact time index 

double. m_dMaxPHD; II max Post-impact Head Decceleration 
int m_nlndexMaxPHD; II time index of max PHD 
double - m_dTHIV ; II Theoretical Head Impact Velocity 

double m _ dOIVx ; II Occupant Impact Velocity x 
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double 

double 
double 

int 
int 

double 
double 
double 

m_dOIVy; II Occupant Impact Velocity y 

m_dMaxRDAx; II max tidedown acceleration x 
m_dMaxRDAy; II max ridedown acceleration y 

m_nMaxRDAxindex; II index of max ridedown acceleration x 
m_nMaxRDAyindex; II index of max ridedown acceleration y 

m_dMaxRollAngle ; II max. Roll angle 
m_dMaxPitchAngle ; II max. Pitch angle 
m_dMaxYawAngle ; II max. Yaw angle 

int m_nMaxRollAnglelndex ; II index of max Roll angle 
int m_nMaxPitchAngleindex; II index of max Pitch angle 
int--- -m"-nMaxYawAnglelndex __ ;// index_ofmaxYawangle _ 

double 
int 

int 
int 

BOOL 
BOOL 

double 
double 
double 

int 
int 
int 

m_dMaxASI; II max Acceleration Severity Index 
m_nindexMaxASI; //time index of max ASI 

m_nOIVImpactSurface ; II impact surface for OIV calc 
m_nTHIVImpactSurface; II impact surface for THIV calc 

m_bOIVImpact ; II occupant impact OIV calc 
m_bTHIVImpact; II occupant impact THIV calc 

m_dMaxAccelXAveraged; II maximum 50msec moving avg. Ax 
m_dMaxAccelYAveraged; II maximum 50msec moving avg. Ay 
m_dMaxAccelZAveraged; II maximum 50msec moving avg. Az 

m _ nMaxAccelXA vglndex ; II index of max. 50msec moving avg. Ax 
m _ nMaxAccelY Avglndex ; II index of max. 50msec moving avg. Ay 
m_nMaxAccelZAvgindex; II index of max. 50msec moving avg. Az 
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Flow Chart 

Following is a state diagram for TRAP. In TRAP there are three states: (1) no 
file opened yet, (2) file opened but not being edited, and (3) file being edited. 
The diagram shows how the program transitions between the different states 
based on interaction from the user. Note that the calculations are run implicitly 
by exiting the Edit Input screen using the "OK" button. 

Show Errors 
Delete current results 

Pre-calc check 

No Errors 

Calculate 

No Errors 

Update Graphsrrables 
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